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1. Version Management 

Version Update Description Table 

Version 
Number 

Content Time 

V1.0 1. Add digital demodulation and pulse option 
measurement description 

2025-3-27 

V1.1 1. Add phase noise test function description 

2. Pulse signal detection version description 

2025-4-3 

V1.2 1. Add pulse signal test in DET mode 2025-4-8 

V1.3 1. Add requirements for operating 

environment and probability density chart 

section 

2. Remove SWP mode pulse detection and 

digital demodulation hardware dongle 

instructions 

2025-4-11 
 

  

V1.4 1. Modify the method for installing licenses for 

pulse detection and digital demodulation 

options. 

2. Modify the method for viewing GNSS 

information. 

3. Modify the IP3 measurement method. 

2025-6-27 

V1.5 1. Add SEM 

2. Add harmonic analysis chapter 

3. Add display offset and theme, parameter 

settings 

4. Add amplitude correction and Graph 

function 

5. Add the chapter of parsing external GNSS 

information 

2025-7-15 
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2. Quick Start Guide 

This chapter is a quick start guide for the PX Series instruments, covering safety instructions, 

instrument power-up and shutdown, instructions for running the host computer software, and 

descriptions of the instrument's external interfaces. 

2.1 Safety Instruction 

2.1.1 Safety Rules 

1. Please check the following items before running the instrument: 

▪ The appearance of instrument is intact; 

▪ The power cable and adapter are not damaged; 

▪ The fan's air vent is unobstructed; 

▪ The instrument is dry, without moisture or condensation; 

▪ The ambient temperature meets specifications in product datasheet; 

▪ If any damage is found before first operation, please contact official after-sales 

service. 

2. During operation, please follow these guidelines: 

▪ The fans work properly and the operating temperature meets the requirements 

from the product datasheet; 

▪ Please connect the external port properly and ensure that input signal level is 

within maximum input power; 

▪ Battery is suggested to be above 5%; 

▪ It is prohibited to open the instrument’s casing to avoid the risk of electric shock; 

▪ In case of any error, please contact official after-sales service. 

3. After completing the use of the instrument, please follow the guidelines below: 

▪ After the instrument is properly shut down, ensure that the storage temperature 

and humidity meet the range specified in the product datasheet. 

2.1.2 Replacing the Power Adapter 

If you are unable to use the original power adapter for certain situations, please select an 

appropriate power adapter according to the corresponding product datasheet. 

2.1.3 Replacing the Battery 

The service for PX series battery replacement is supported. If you need to replace the battery, 

please contact official after-sales service for assistance. 

2.2 External Interface Description 

All external interfaces are integrated on the top panel of PX series instrument. Please refer to 

Table 1 for detailed information of each interface. 
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Figure 1 Front panel interface description 

Table 1 Detailed information of external interface 

No Interface Description 

1 Power On/Off instrument 

2 Charging 
Instrument charging port, USB PD 20V 3.25A. Please 
connect the power supply according to the datasheet 

3 Micro HDMI For extended display 

4 USB3 
USB interface: USB3 is USB 3.0 interface, USB1 and 
USB2 are USB 2.0 interface. This interface connects to 
external storage devices, USB keyboards, or mice. It 
can also be used to connect a driver-free Hub with an 
Ethernet port, allowing the instrument to be remotely 
controlled by a PC via network cable 

5 USB2 

6 USB1 

7 Audio Output 3.5mm headphone jack. Volume can be adjusted via 
the menu: “System” -> “Device” -> “Volume.” 

8 MUXIO Please refer to Table 2 for more details 

9 Charging Indicator 
Light 

Green flash indicates charging, and green solid light 
indicates a full charge 

10 Analog IF Output MMCX(F), maximum output power -25 dBm, output 
impedance 50 Ω 

11 Trigger Output 3.3V CMOS 

12 Trigger Input 3.3V CMOS, high impedance input 

13 
Reference Clock 
Input 

MMCX (F), amplitude 1.5Vpp, input impedance 330 Ω. 
Sine wave, square wave, and clipped sine wave are 
supported 

14 GNSS Antenna MMCX (F), amplitude 1.5Vpp, input impedance 330 Ω 

15 RF Input N (F) or 2.4 mm (M), input impedance 50 Ω 
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Table 2 Pin description for MUXIO interface 8 (from left to right) 

Pin Name Direction Voltage 
Standard 

Description 

1 GPIO0 / / Reserved 

2 TRG IO2 / / Reserved 

3 GPIO1 / / Reserved 

4 GND / / Ground 

5 GPIO2 / / Reserved 

6 3V3/5VIN O / 
Power output, 5V output 
for PXN-400 and PXE 
series 

7 GPIO3 / / Reserved 

8 GND / / Ground 

9 USART_TX_FP / / Reserved 

10 SYNC_RXRFLO I 3.3V RF LO synchronization 

11 SYNC_ADCCLK I 3.3V ADC clock 
synchronization 

12 SYNC_RXIFLO I 3.3V IF LO synchronization 

13 GND / / Ground 

14 REFCLK_OUT_FP O / 
Reference clock output 
outputs a standard clock 
signal of 10 MHz 

2.3 First Use of the Instrument 

The battery level may be below 5% after long-distance transportation. It is recommended to 

connect the power adapter before powering on the instrument for the first time. 

2.3.1 Power On/Off the Instrument 

Turn on/off the instrument using the power button (Interface 1) on the top of the instrument. 

After powering on, the blue power indicator will light up. After powering off, the power indicator 

light will go out. 

2.3.2 Charging Indicator 

When the instrument is connected to the power adapter, the charging status light (Interface 9) 

will flash green. Once fully charged, the charging status light will always stay on green. 
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2.3.3 Launch the Application Software 

Press the power button to turn on the instrument. After booting up, the instrument will enter the 

desktop and automatically launch the application software. 

3. Application Software Operation Overview 

This chapter mainly explains the UI layout, working modes, and common features of application 

software. 

3.1 Working Modes Overview 

PX series handheld spectrum analyzers offer working modes, including Standard Spectrum 

Analysis (SWP), IQ Streaming (IQS), Power Detection Analysis (DET), Real-time Spectrum 

Analysis (RTA), Phase Noise Measure and Basic Digital Demodulation. The measurement 

functions available in each working mode will be explained in the following sections. 

3.1.1 Standard Spectrum Analysis (SWP) 

In SWP mode, the instrument performs frequency hopping to realize frequency sweep. This 

mode is suitable for frequency trace-based measurement and analysis applications. The 

measurement and analysis functions provided in SWP mode include: 

◼ Spectrum panoramic sweep ◼ IP3/IM3 

◼ Local spectrum zoom display ◼ Channel Power 

◼ Spectrogram (Waterfall) ◼ OBW 

◼ Spectrum record and playback ◼ ACPR 

◼ Signal tracking ◼ Peak table 

3.1.2 IQ Streaming (IQS) 

In IQS analysis mode, the instrument keeps the LO configuration unchanged to obtain IQ time 

domain data. IQS mode is suitable for time-domain signal recording, basic demodulation 

analysis, and other applications. The functions provided in IQS mode include: 

◼ IQ time domain waveform ◼ Spectrum analysis of IQ data 

◼ Spectrogram(Waterfall) ◼ AM/FM demodulation 

◼ Power-time waveform ◼ Audio analysis 

◼ Multi-channel DDC ◼ IQ record and playback 

◼ Pulse signal detection (option)  

3.1.3 Power Detection Mode (DET) 

In DET analysis mode, the instrument keeps the LO configuration unchanged to obtain IQ time 

domain data. DET mode is suitable for observing the relationship between time and power 

within a certain bandwidth. The functions provided in DET mode include: 

◼ Power-time waveform and 

zoomed waveform 

◼ DET data recording and 

playback 

◼ Pulse signal detection (option)  
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3.1.4 Real-Time Analysis Mode (RTA) 

In RTA analysis mode, the instrument keeps the LO configuration unchanged to obtain IQ time 

domain data. RTA mode is suitable for applications that focus on transient and burst signals. 

The functions provided in RTA mode include: 

◼ Real-time spectrum probability 

density graph and 

Spectrogram(Waterfall) 

◼ Real-time spectrum data 

recording and playback 

3.1.5 Harmonics 

In the Harmonics working mode, the instrument analyses the signal harmonically based on the 

fundamental and displays the frequency and amplitude of each harmonic and its difference 

from the fundamental. This mode is suitable for analysing harmonic distortion in signals and 

helps to identify and evaluate non-linear characteristics of signals. The functions provided by 

the Harmonic Analysis mode include: 

◼ Harmonic spectrum diagram ◼ Harmonic measurement table 

3.1.6 Phase Noise Measurement Mode (PNM) 

In phase noise measurement mode, the instrument provides high-precision phase noise 

spectra and detailed data tables through automated measurement technology. These 

measurement results help users to deeply analyze the phase stability, noise distribution, and 

noise density at different frequency offsets of the signal. The functions provided by the phase 

noise measurement mode include: 

◼ Single-sideband phase noise 

spectrum diagram 

◼ Phase noise measure table 

3.1.7Digital Demodulation Mode (Option) 

In digital demodulation mode, the instrument demodulates the modulated signal and analyzes 

the modulation quality from various perspectives. The demodulation functionality is suitable for 

multiple applications, especially in environments where known modulated signals need to be 

analyzed, quality-assessed, and data extracted. The functions provided in digital demodulation 

mode include: 

◼ Constellation and eye diagram ◼ Bit table and demodulation 

◼ Modulated signal spectrum 

analysis 
◼ ASK/FSK/PSK/GMSK/QAM 

3.2 Application Software UI Layout 

The application software UI consists of the following sections: 

◼ Menu ◼ Graph Set Area 

◼ Graph Display Area ◼ Main Setting Area 
◼ Instrument State ◼ Parameter Quick Set 
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Figure 2 Application Software UI Layout 

3.2.1 Menu  

◼ Save and load configuration ◼ Set startup state 

◼ Working mode switch ◼ System setting  

◼ Single/Continue preview ◼ Record and playback 

◼ Quick screenshot ◼ GNSS, Instrument Information View 

3.2.2 Graph Set Area 

◼ Graph settings ◼ Trace settings 

◼ Marker settings ◼ Display Measurement Results 

3.2.3 Main Settings Area 

◼ Measurement and analysis settings ◼ Trigger settings 

◼ Data record and playback ◼ System settings 

3.2.4 Instrument State 

◼ Instrument model ◼ Software and firmware versions 

◼ Current instrument temperature ◼ Bus data throughput 

◼ GNSS antenna connection status ◼ Instrument battery status 
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4. Common Operation 

4.1 Common Functions Overview 

4.1.1 Save and Recall Instrument Configuration 

1. Save the current configuration 

(1) Click "File" in the menu bar and select "Save State"; 

(2) In the "Save State" pop-up window, set the save path and file name, then click "Confirm" to 

save the configuration file. 

2. Load configuration 

(1) Click "File" in the menu bar and select "Recall State"; 

(2) In the "Please Select file" dialog, choose the configuration file and click "Confirm" to open 

the previously saved configuration. 

4.1.2 Power On State Settings 

PX series spectrum analyzers allow users to configure the instrument's power on state. The 

supported power on states is listed in Table 3. 

Table 3 Application Software Startup State 

No Power On State Description 

1 Default Default configuration 

2 User Preset Use a user-saved configuration file as the startup state 
configuration 

3 Last State Use the parameter configuration when last software exit as 
the startup state configuration 

To configure the power on state, follow these steps: 

1. Click “File” in menu bar, and select “Power On State” to set the software startup state; 

2. For "Default" and "Last State", simply click the corresponding option. The software will use 

the state as the initial startup state when it is launched for the next time; 

3. To select "User Preset," click on the "Please Select File" dialog that appears, choose the 

user-saved configuration file, and then click "Confirm." The software will start with the user-

specified configuration next time. 

4.1.3 Working Modes Switch 

Click on "Mode" to switch working mode to SWP, IQS, DET, RTA, PNM, Harmonic analysis mode 

or Digital Demodulation. 
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Figure 3 Working Mode Switch 

4.1.4 Save Screenshot 

1. Click “File” in the menu bar, and select “Save Image”; 

2. In the “Save Image” dialog, set the image save path and file name, then click “Confirm” to 

save the screenshot (when no external storage is connected, the image will be saved locally by 

default; when external is connected, you can choose to save directly to external disk). 

Alternatively, you can use the shortcut key in the menu bar " " for quick screenshot. 

4.1.5 Preset 

Click on "Preset" to quickly restore the software configuration to the instrument's default state. 

4.1.6 Single or Continuous Preview 

Single Preview: Click "Single", Continuous Preview: Click "Continue". 

4.1.7 Quick Record and Playback 

Quick Record: Click "Rec" to start recording data, and click "Stop" to stop recording. 

Playback: Click "Play" to play back the most recent recorded data, and click "Pause" to pause 

playback. 

Click the "Continu." button to resume normal data acquisition and display. 
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Figure 4 Quick Record and Playback 

4.1.8 Professional or Basic Settings 

Click "System" in the menu bar, then select "Setting Mode" to choose either "Basic" or 

"Professional" mode. Compared to the basic settings, the professional settings provide more 

parameters in the main settings area. Users can choose the appropriate setting mode based on 

application. 

4.1.9 Theme Settings 

Click "System" in the menu bar, then select "Theme" to choose either "Dark" or "Light" mode. 

4.1.10 Preference Settings 

Click "System" in the menu bar, then select "Preference", set functions below in pop-up window. 

Table 1 Overview of Preference Settings 

Preference Overview 

Haptics If enabled, the instrument will provide haptic feedback through vibration 
when operating the instrument on the touch screen 

Screen Lock If enabled, the lock icon " " will appear on the right side of the screen, 
click on the icon to " " to lock the screen to prevent misuse, click again to 
unlock it 

Digital Det If enabled, the display refresh frequency of some parameters, including 
the marker, will be reduced, making it easier for users to observe and 
record. 

Auto-Dim If enabled, the instrument will automatically reduce the brightness of the 
screen to save energy consumption if the user does not have any 
operation within one minute. 

4.1.11 Hide Panel 

Click the hide icon “ ” in the menu bar to hide the main settings menu and expand the display 

area. 
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4.1.12 Current Instrument Information 

Click “System” in the menu bar, and select “About”, the current instrument information will be 

displayed in the "About" popup window. 

4.1.13 Spectrogram 

Spectrogram(waterfall) plot functionality is supported only in SWP, IQS, and RTA modes. Click 

on the spectrogram in the graph settings area to access the spectrogram settings. The controls 

for the spectrogram plot are introduced in the table 5: 

Table 4 Spectrogram Controls 

Graph Settings Area  

Scan Depth the time length cached on the y-axis of the spectrogram 
Cache limit: 8000 lines of pixels 

Time Density the refresh rate of the spectrogram 
When set to 100, scrolls 100 lines of pixels per second 

ColorGradation Sets the color gradient for the spectrogram 

1. Click "Graph" to open "Spectrogram" and create a corresponding spectrum waterfall graph. 

 

Figure 5 Enable Spectrogram 

2. Click the waterfall chart, switch to the corresponding chart setting area, and then click 

"Graph" -> "Export Data", you can export the currently cached data that does not exceed the 

scanning depth to CSV format (the default export path: (default export path: 

"/media/rpdzkj/userdata/Studio/data"), and the exported data will be sorted in reverse 

chronological order. 

4.1.14 Graph Zoom Function 

Graph zoom function can be used to view the details of the local area in the spectrum graph or 

time-domain graph, the instrument provides two kinds of zoom: Zoom function and magnifying 

glass function, the user can choose flexibly according to the needs. 
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1. Zoom Function 

(1) Spectrum Zoom (Only in SWP Mode) 

1) Click "Graph" and open "Zoom" in the pop-up submenu; 

2) Click to select the spectrum zoom graph, then click "Graph" In the pop-up submenu, set 

the desired frequency range to zoom in on, or directly drag the zoom box and its edges on the 

spectrum graph to adjust the position and zoom area. 

 

Figure 6 Spectrum Zoom in SWP Mode 

(2) Time Domain Zoom (Only in IQvT, PvT, and DET Modes) 

1) IQvT and PvT 

In IQS mode, click "IQvT" or "PvT" in the main settings area, select the corresponding channel, 

then open "Analyze" and "Zoom". Adjust the zoom area by holding and sliding the zoom box or 

dragging the zoom edges left or right. 

2) DET mode 

a) Click "Graph" and open "Zoom" in the pop-up submenu; 

b) Adjust the zoom area by holding and sliding the zoom box, dragging the zoom edges left 

or right, or selecting "PvT Zoom." Then click "Graph" to set "TimeCenter" and "TimeRange" to 

adjust the zoom area. 

2. Magnifying Glass Function 

(1) Click on the magnifying glass button " " to frame the area of interest; 
(2) A thumbnail view will be displayed in the upper right corner of the main interface, showing 

the complete trace and the position of the magnified area in the global diagram; 

(3) Users can quickly switch the position of the zoomed-in area by dragging the red box in the 

thumbnail view, or they can re-frame a new area to zoom in; 

(4) Clicking the Zoom button again to exit the zoomed-in view and re-display the original trace. 
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Figure 7 Magnifying Glass Zoom in SWP Working Mode 

4.1.15 Record and Playback 

Please refer to table 6 for key parameters in record and playback function. 

Table 5  Record and playback parameter description 

Record  

RecordMode 

Fixed Duration: Allows presetting the number of recording points and 
file size (must not exceed file storage limit) 
Manual Mode: Requires manual control over the number of recording 
points(Note: In manual mode, the software will automatically stop 
recording when the size of the recording file exceeds the single file 
size limit) 

RecordTime 
Set the recording duration, only effective when the record mode is 
"Fixed" 

FileSizeLimit The storage size limit for a single recording file 

Disk the remaining and total disk capacity 

Playback  

Last frame Rewind by one frame 

Next frame Fast forward by one frame. 

Back Rewind by multiple frames. 

Forward Fast forward by multiple frames. 

1. Data recording 

(1) Click "Record" in the main settings area, then click the "RecordMode" submenu to select the 

recording mode; 

(2) Click "File Path" to set the storage path of the log file, the default storage path is: 

"/media/rpdzkj/userdata/Studio/data", users can customize the storage location, if the 
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external memory is connected, you can also choose to save the log file to an external device. 

You can customize the storage location, and if you have connected an external storage device, 

you can also choose to save the log file to the external device; 

(3) In Fixed Duration Mode, click "Record on" to automatically record the preset amount of data. 

In Manual Mode, click "Record on" and "Record off" to manually control the recording duration. 

The recording will automatically stop when the file size exceeds the available disk capacity. 

2. Data playback 

(1) Click the "Open File" button under "Play Back" in the main settings area, select the recording 

file to be played back in the pop-up window, and click "Confirm"; 

(2) Click "Play Back" to start playback, "Pause" to stop, and "Stop" to exit playback and resume 

data acquisition. Set the "PlaybackRate" value to adjust the playback speed. Enabling "Auto 

Loop" will loop the playback of the selected file. 

4.1.16 Export Data 

1. Click "Graph" in the corresponding graph settings area, then select “DataExport” from the 

pop-up submenu. The “image” option allows you to export the chart data as an image, while the 

"Data" option exports the chart data as a CSV file; 

2. In the "Save" pop-up window, set the data save path and file name, then click "Confirm" to 

save the image/CSV file. If no external storage is connected, the file will be saved locally; if 

external storage is connected, you can choose to save directly to the storage device; 

3. PX Series instruments store data by default in subfolders under the 

“/media/rpdzkj/userdata/Studio” folder, including images (chart pictures), data (record files 

and configuration files), and reports (chart data CSV files and corresponding configuration files). 

4.1.17 Delete Files and Images 

1. Click "File" -> "Exit" to exit the application software; 

2. Go to "/media/rpdzkj/userdata/Studio/images", drag and drop the image to "Trash Can", 

and click "Yes" in the Confirm pop-up window. Click "Yes" in the Confirm pop-up window to 

delete the screenshot (the deletion of log files and configuration files is the same as the deletion 

of screenshots). 
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Figure 8 Delete Image 

4.1.18 Modify Sampling Rate 

In IQS mode, click "BW" in the main settings area, and modify the value of "IQSampleRate" in the 

submenu to change the instrument's sampling rate. 

 

Figure 9 Modify the Native Sampling Rate 

4.1.19 Quick Parameter Settings 

The quick parameter settings currently support fast configuration of commonly used spectrum 

analysis parameters, including reference level, RBW (Resolution Bandwidth), VBW (Video 

Bandwidth), detector, start frequency, stop frequency, sweep span, center frequency, and 

more. 
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Figure 10 Quick Parameter Settings 

4.1.20 Offset 

1. Click "Graph" -> "Offset" in the chart setting area, and enter the offset value in the offset 

setting interface, where a positive value indicates that the trace is offset downward and a 

negative value indicates that the trace is offset upward. 

2. Users can also click on the " " icon in the chart setting area, and after enabling it, they can 

directly drag the position of the trace on the display by sliding their fingers up and down, so as 

to realize quick adjustment. 

4.2 Amplitude Correction 

To ensure the accuracy and repeatability of spectrum measurements, the instrument provides 

an amplitude correction function, which supports the user to compensate by manually 

inputting external gain/loss and importing the frequency response correction table. 

4.2.1 Correction Rules 

▪ between the starting frequency and the first compensation point within the current sweep 

width, compensated according to the offset value of the first frequency point; 

▪ Between multiple compensation points, compensation is performed by linear 

interpolation according to the frequency data in the correction table; 

▪ between the last compensation point and the termination frequency, compensated 

according to the correction value of the last frequency point. 

4.2.2 Amplitude Correction Example 

Take 1 GHz-3 GHz band compensation -20 dB, 3 GHz-5 GHz band -20 dB-10 dB interpolation 

compensation, 5 GHz-7 GHz band compensation 10 dB as an example, the operation steps are 

as follows: 

1. Click "Frequency", set "Start Frequency" to "1 GHz", "Stop Frequency" to "1 GHz", and "Start 
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Frequency" to "1 GHz". Click "Frequency" and set "Start Frequency" to "1 GHz" and "Stop 

Frequency" to "7 GHz"; 

2. Click "System" -> "Amplitude Correction" in the menu bar; 

3. Enable the amplitude correction function in the pop-up window, and then click "Add" to 

add one frequency correction item at a time; 

4. Set Frequency1 to "3 GHz" and Offset1 to "-20 dB", click Add again, and set Frequency2 to 

"5 GHz" and Offset2 to "10 dB". "10 dB"; 

5. Click "Apply" in the lower right corner of the pop-up window to apply the amplitude 

correction function; 

 

Figure 11 Amplitude correction application 

6. Users can export the current correction configuration to an Excel table file via "Export" in 

the pop-up window. (The default path is "/media/rpdzkj/userdata/Studio/data"); 

7. Users can also customize the amplitude correction table according to the format of the 

exported configuration and import it through the "Import" button. 

4.3 Graph function 

See the following table for a detailed description of the Graph submenu parameters in the 
Graph Setup area: 
Table 2 Chart Functional Parameter Description 

Diagrams  

Scale/Div 
Adjusts the interval between each grid line of the display screen. 
Range: 1 dB - 100 dB 

Offset Refer to Offset section 

ScaleReset Restore the display state of the chart to the default configuration 

Units dBm、dBmV、dBmA、W、V、A、dBuV、dBuA、dBpW 
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Spectrogram Refer to Spectrogram section 

Zoom Refer to Graph Zoom Function section 

Marker Pair Refer to Marker Function section 

DataExport Refer to Data Export section 

4.4 Marker Function 

The marker function is configured in the "Marker" submenu under the Graph Settings area. 

Besides, application software also provides some quick operations to use markers. This section 

will explain in detail how to use markers in application software. 

4.4.1 Create Markers 

1. Create a Marker 

Double-click in the Graph Display area or click the "Peak Search" button in the Graph Settings 

area to quickly create a marker. 

2. Create multiple Markers 

Click the "Marker" submenu in the Graph Settings area, select the marker you want to create, 

and then click "Enabled" to activate the marker. 

4.4.2 Create Marker pair 

Click "Graph" in the Graph Settings area, then select "Marker Pair" in the popup window to 

quickly create a pair of reference markers and delta markers. Click repeatedly to enable 

multiple pairs of markers(currently up to 5 groups). 

4.4.3 Close Markers 

1. Close a single Marker 

Click the "Marker" submenu in the Graph Settings area, select the marker you want to close, and 

then click "Enabled" to disable the selected marker. 

2. Close All Markers 

Click "Graph" in the Graph Settings area, then select "Clear All" in the popup window to close all 

markers. 

4.4.4 Change Markers Frequency 

In instruments equipped with a touch screen, users can flexibly modify the frequency position 

of the markers in a variety of ways to observe and analyze signal characteristics more precisely. 

Two commonly used methods are described below: 

1. Input the frequency value manually 

Click the "Marker" sub-menu, select the enabled markers (e.g. M1R, M2R), click the "Frequency:" 

area on the top of the pop-up window, and set the marker frequency value. 

2. Drag the marker or click to jump. 

(1) Drag Marker: Press and hold the marker and drag it to the desired position, then release it; 

(2) Click to jump: double click the target frequency point after selecting the marker, the marker 

will jump to the position automatically. 
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4.4.5 Marker Peak Search 

1. Local peak search 

Double-click near the local peak in the graph, or select a marker and click "Marker" -> "Local 

Peak" to enable local peak search. 

2. Global peak search 

Click "Peak Search" to enable global peak search. 

4.4.6 Delta Marker 

The delta marker is typically applied alongside the reference marker to indicate the frequency, 

time and amplitude difference between the reference marker and the delta marker. 

 

Figure 12 Enable Delta Marker 

4.4.7 Noise density 

After creating a marker, open "NoiseDensity" in the "Marker" submenu under the Graph Settings 

area to convert the original power value into power density per Hertz. 

4.4.8 Marker to Center 

After moving the reference marker to the target frequency, click "to Center" in the "Marker" 

submenu under the Graph Settings area to align the marker's frequency to the center position. 

4.4.9 Marker Switch To Mode 

After moving the reference marker to the target frequency, click the "Switch To" button in the 

"Marker" under the Graph Settings area to quickly switch to another working mode and set the 

frequency value of the current marker position as the center frequency of the new mode. 
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Figure 13 Marker Switch to Mode 
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5. GNSS Usage Instruction 

This chapter will detail how to use the instrument's built-in or external user-defined GNSS 

module to acquire real-time positioning data and how to use the 1PPS trigger of the built-in 

GNSS module. 

5.1 Using an external GNSS module 

The instrument supports access to user-defined external GNSS modules via USB to serial port. 

Users can connect the serial output of the module to the USB port of the instrument via USB to 

serial cable, and the system will recognize it as a virtual serial port and parse the received GNSS 

data. The operation steps are as follows: 

1. Connect the external GNSS module to the USB port of the instrument with the USB to serial 

cable; 

2. Click "System" in the software and select "GNSS Information" in the drop-down menu; 

3. In the pop-up window, set "GPS Type" as "External GPS"; 

4. Click the "Refresh" button in the "COM Device" column, and select the newly recognized 

"ttyUSBX" device; 

5. Set the "Baud Rate" to the actual output of the GNSS module (e.g. "9600"), and click the 

"Connect" button at the bottom; 

6. The instrument will parse and display the received GNSS positioning information, see the 

following table for the explanation of the parameters in the GNSS information pop-up window. 

 

Figure 14 Connecting an external GNSS module 

Table 3 GNSS Parameters Overview 

serial 
number 

Parameters Overview 

1 GPS Type Selection of internal/external GNSS module 
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2 Baud Rate Serial Baud Rate for External GPS Module 
Required when using external GNSS module only 

3 Format Provides both "local time" and "UTC time" time formats. 

4 Antenna Select "Internal Antenna" or "External Antenna" (currently 
only external antennas are supported). 
Required when using internal GNSS module only. 

5 SatNum Number of satellites positioned 

6 SNR(Max) Maximum signal-to-noise ratio of positioned satellites 

7 SNR(Min) Minimum signal-to-noise ratio of positioned satellites 

8 SNR(Avg) Average signal-to-noise ratio of positioned satellites 

5.2 Use Internal GNSS Module 

5.2.1 Connecting the GNSS Antenna 

Connect the antenna and the MMCX to SMA cable, and connect the MMCX end to the GA port 

of the instrument (when using an external GNSS antenna, point the receiving side of the 

antenna toward the unobstructed sky). 

 

Figure 15 Connecting the GNSS external antenna 

5.2.2 Locking internal GNSS 

1. Click "System" -> "GNSS Info", and set "GPS Type" to "Internal GPS" and "Antenna" to 

"External" in the GNSS Info box; 

2. Wait for 1-3 minutes for the GNSS to lock, you can judge whether the GNSS is locked or not 

according to the GNSS lock logo in the status bar information, after locking, the GNSS lock logo 

will be green, if it is gray, then it is not locked. 
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Figure 16 Locked GNSS external antenna 

5.2.3 1PPS Trigger Using the Internal GNSS Module 

Only IQS mode, DET mode and RTA mode can use 1PPS trigger of GNSS module. This section 

will take IQS mode as an example to explain in detail how to configure the 1PPS trigger function 

of the GNSS module. 

1. Please refer to Connecting the GNSS Antenna section to connect the instrument and 

antenna correctly; 

2. Please refer to the section of Locking Internal GNSS to make sure the GNSS is locked; 

3. Click "Mode" -> "IQStreaming" to switch to IQS mode; 

4. Click "Next" -> "Trigger" in the main setup area, and in the "Trigger" sub-menu, set the 

"TriggerSource" as the "Trigger Source". In the "Trigger" submenu, set "TriggerSource" to GNSS-

1PPS to use the 1PPS trigger of the GNSS module. 
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Figure 17 Triggered by GNSS 1 PPS 

5.2.4 Notes for Internal GNSS Usage 

1PPS trigger of GNSS is not recommended when the GNSS module is not locked. 
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6. SWP Working Mode 

This chapter will provide you with important parameters and measurement methods for SWP 

mode. 

6.1 SWP Working Mode Parameters Overview 

Important parameters for the SWP mode are listed in Table 9. 

Table 9 Parameters description in SWP working mode 

Frequency  

LO optimization 

Auto: default low spurious mode; 
Speed: high sweep speed mode; 
Spur: low spurious mode; 
Phase noise: low phase noise. 

Amplitude  

Pre-Amplifier 

Preamplifier setting: 
Auto: automatically enables the preamplifier; When the reference 
level is below -30 dBm, the preamplifier is manually on or off; 
Forced off: always off. 

Gain Strategy 
Low Noise: minimizing noise while maintaining a flat noise floor. 
High Linearity: achieving high linearity while maintaining the noise 
floor flat. 

IF Gain Grade 

Gain grade 0-X: each grade for 3dB gain; 
Increase IF Gain Setting: RF gain decreases, noise floor increases, 
linearity improves, spurious signals decrease 
Decrease IF Gain Setting: RF gain increases, noise floor 
decreases, linearity degrades, spurious signals increase 

Attenuation 

0-33 dB (upper limit is different for different frequency bands), 
1 dB step; 
Atten = -1dB (default): attenuation is off. 

Atten ≥ 0dB: attenuation is enabled, and the reference level is 
calculated as Reference Level = Attenuation Value - 10. 

Sweep  

Sweep Time Mode 

min SWT: minimum sweep time; 
min SWTx2: approximately 2 times of min SWT; 
min SWTx4: approximately 4 times of min SWT; 
min SWTx10: approximately 10 times of min SWT; 
min SWTx20: approximately 20 times of min SWT; 
min SWTx50: approximately 50 times of min SWT; 
min SWTxN: approximately N times of min SWT, 
N=SweepTimeMultiple; 
Manual: approximately equal to the target sweep time. 

Trace Points Strategy 
Sweep Speed: priority is given to the fastest sweep speed; 
Points Accuracy: priority is given to ensuring that the number of 
trace points is close to the target. 

Spurious rejection Bypass, standard and enhanced. 
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6.2 Channel Power 

A BPSK signal with a carrier frequency of 1 GHz, power of -20 dBm and symbol rate of 1 MHz is 

as input to spectrum analyzer. 

6.2.1 Parameter description 

This section provides an explanation of some important parameters in channel power 

measurement mode, as listed in Table 10. 

Table 10 parameters for channel power measurement 

Channel Power  

Meas BW 
the bandwidth of the channel to be measured; channel power is 
the integrated power within this bandwidth 

Span Power 
the measurement bandwidth to the current span and calculates 
the channel power within this range 

6.2.2 Instruction steps 

1. Set the center frequency as 1 GHz and reference level as 0 dBm. Click the "Meas" menu and 

select "ChannelPower" from the dropdown menu; 

2. Parameters are automatically configured to default parameters. The results are shown in 

the figure below. The top left corner of the measurement box displays the channel power value. 

The "Channel Power" section below also shows the measurement bandwidth, channel power, 

and power spectral density values; 

3. You can also manually adjust the channel center frequency (drag to select the 

measurement area) and the measurement bandwidth (drag the measurement border left or 

right or adjust the Meas BW settings), you can also modify "Center Frequency", "Span", 

"Reference Level", "RBW" and other parameters in the main setup area to adapt to the 

measurement of different signals. 

FFT execution 

Auto: automatically selects the CPU or FPGA for FFT calculation 
based on the settings (using CPU for RBW below 30 kHz and 
FPGA for RBW above 30 kHz), CPU preferred, FPGA preferred, 
CPU Low Occ, CPU Mid Occ, CPU High Occ, FPGA only. 

Window type 

FlatTop Window: higher amplitude accuracy. 
B-Nuttal Window: greater frequency selectivity. 
LowSideLobe Window: higher accuracy in measuring low-
frequency signals. 
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Figure 18 Measure Channel Power 

6.3 Occupied Bandwidth 

A BPSK signal with a carrier frequency of 1 GHz, power of -20 dBm and symbol rate of 1 MHz is 

as input to spectrum analyzer. 

6.3.1 Parameter description 

This section provides an explanation of some important parameters: Important parameters for 

occupied bandwidth measurement are listed in Table 11. 

Table 11 Occupied bandwidth measurement parameter description 

Parameters 

Method XdB, Percentage 

XdB/Percent the specific XdB value or percentage 

6.3.2 Instruction step 

1. Set the center frequency as 1 GHz and the reference level as 0 dBm. Click the "Meas" menu 

and select "OBW" from the dropdown menu; 

2. Click the "BW" and set the "RBW" to 50 kHz; 

3. Parameters are automatically configured to default parameters. The results are shown in 

the figure below. The occupied bandwidth value can be viewed in the "OBW" section below; 

4. You can also modify "Center Frequency", "Span", "Reference Level", "RBW" and other 

parameters to adapt to the measurement of different signals. 
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Figure 19 Measure OBW 

6.4 Adjacent Channel Power Ratio (ACPR) 

A BPSK signal with a carrier frequency of 1 GHz, power of -20 dBm and symbol rate of 1 MHz is 

as input to spectrum analyzer. 

6.4.1 Parameter description 

This section provides an explanation of some important parameters: Important parameters for 

adjacent channel power ratio (ACPR) measurement are listed in Table 12. 

Table 12 ACPR Measurement Parameter Description 

Adjacent Channal Power 

Adjacent Channel 
Offset 

Sets the frequency separation between main channel and adjacent 
channel. 

Number of Adjacent 
Channel Pairs 

Configures the quantity of adjacent channel pairs (Maximum: 2 
pairs). 

6.4.2 Instruction step 

1. Set the center frequency as 1 GHz and the reference level as 0 dBm. Click the "Meas" menu 

and select "ACPR" from the dropdown menu; 

2. Parameters are automatically configured to default parameters. The results are shown in 

the figure below. The power values of each channel are displayed at the top of the green 

channel bandwidth. The "ACPR" section below also shows the adjacent channel center 

frequency, adjacent channel power, and adjacent channel power ratio; 

3. You can also manually set the center frequency of the main channel, the bandwidth of each 

channel, the spacing of adjacent channels, and the number of adjacent channel pairs. You can 

also modify "Center Frequency", "Span", "Reference Level", "RBW" and other parameters to 

adapt to the measurement of different signals. 
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Figure 20 Measure ACPR 

6.5 IP3/IM3 

Center frequency point of 1 GHz is utilized for IP3/IM3 measurement. 

6.5.1 Parameter description 

This section provides an explanation of some important parameters: Important parameters for 

IP3/IM3 measurement are listed in Table 13. 

Table 13 IP3/IM3 measurement parameter description 

IP3/IM3 

LowToneFrequency Frequency of the input low-frequency signal 

LowTonePower Power of the input low-frequency signal 

HighToneFrequency Frequency of the input high-frequency signal 

HighTonePower Power of the input high-frequency signal 

LowIM3PFrequency Low-side intermodulation frequency 

LowIM3PPower Low-side intermodulation power 

HighIM3PFrequency High-side intermodulation frequency 

HighIM3PPower High-side intermodulation power 

TonePowerDiff 
Power difference between the high and low 
frequency signals 

6.5.2 Instruction step 

1. Two signals with one signal having a center frequency of 999 MHz and amplitude of 0 dBm, 

and the other having a center frequency of 1.001 GHz and amplitude of 0 dBm is combined using 

a combiner. Then it is as the input signal to the spectrum analyzer; 
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2. Set the spectrum analyzer's center frequency as 1 GHz and the reference level as 0 dBm. 

Click the "Meas" menu and select "IM3" from the dropdown menu; 

3. Adjust the signal power so that the third-order intermodulation distortion signal appears 

more than 10 dB higher in the frequency spectrum; 

4. Parameters are automatically configured to default parameters. The results are shown in 

the figure below. The "IM3" section at the bottom displays the IP3 test results. 

  

Figure 21 Measure IP3/IM3 

6.6 SEM 

The Spectrum Emission Template (SEM) is a measurement function used to evaluate wireless 

signals for excessive emissions or spurious signals outside of the operating frequency band. 

As an example, an IEEE 802.11ac signal with a frequency of 1 GHz and a power of -20 dBm is 

evaluated for compliance with the standard. 

6.6.1 Parameter description 

Only some of the important parameters are described here: some of the important parameters 

for SEM measurements are shown in Table 14. 

Table 4 Description of SEM measurement parameters 

SEM 

Auto 
Parameter 
Setup 

Links with peak reference type. When enabled, automatically uses the 
signal peak as the current relative reference value. 

Reference 
Type 

Manual: When enabled, allows user-defined relative reference level. 
Peak: When enabled, uses the current signal peak as the relative reference 
level. 

Manual 
Reference 

Sets the relative reference level value. This function is only active when 
"Manual" is selected as the reference type. 
The manually set reference value serves as the baseline for calculating the 
start/stop thresholds in the offset table. 

Offset Table Start/Stop Frequency Set the upper offset frequency band, 
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indicating the offset distance relative to 
the center frequency. The system 
automatically generates symmetrical 
upper and lower offset frequency bands, 
with up to 16 configurable offset bands. 
 

Start/Stop Threshold 

Set the power limit for signals within the 
corresponding upper and lower offset 
frequency bands. 
 

Mode 

Absolute: Measure using absolute 
amplitude, with actual power values as 
the benchmark, independent of the 
reference value; 
Relative: Measure relative to the set 
"Manual Reference" value, calculating 
power limits within the offset bands 
based on the reference value. 
 

Priority 

Requirement: Must meet template 
specifications; failure to comply is 
deemed unqualified; 
Suggestion: Recommended to comply 
with template specifications; a warning is 
issued if not met. 
 

Save Table 

Save the current measurement template. 
Default path: 
"/media/pgdzk/userdata/studio/data". 
 

Load Table 
Load a user-saved measurement 
template. 
 

Load Template 

Select an appropriate template from the 
device's predefined templates. 
 
Template types: 802.11a/g, 802.11b, 
802.11n (20MHz, 40MHz), 802.11ac 
(20MHz, 40MHz, 80MHz, 160MHz), AM 
NRSC, FM FCC 73.317, FM NRSC Hybrid, 
AM NRSC 5K Hybrid, AM NRSC 8K 
Hybrid, Bluetooth. 

Exporting 
measurement 
results 

Export of the measurement table below the trace in tabular form. 
Default path: "/media/rpdzkj/userdata/studio/reports" 

6.6.2 Instruction step 

1. Set the "Centre Frequency" to 1 GHz and the "Reference Level" to -20 dBm; 

2. Click "Meas" and select "SEM" in the additional menu; 

3. Click "Offset Table", select the "Load Template" button in the pop-up window, and select 

"802.11ac (20MHz)" template in the template list. Select "802.11ac (20MHz)" template in the 

template list; 

4. Click "BW", adjust "RBW" to "5 kHz" and "VBW Mode" to "VBW = 5 kHz". VBW mode" to "VBW 

= 0.01 RBW"; 

5. Click "Sweep", set "Sweep Time Mode" to "minSWT×20" in the additional menu, and set 

"Detect" to "5 kHz" and "VBW Mode" to "VBW = 0.01 RBW". Detect" to "Average Detect"; 
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6. the measurement results are shown in the figure below, the spectrum will show whether the 

spectrum meets the requirements of the template, and the maximum margin on each offset 

band is shown in the table below the measurement results. 

 

Figure 22 SEM measurements 

6.7 Frequency Tracking 

1. Click the "Marker" in the chart settings area. In the pop-up submenu, click "More", then click 

"Advanced". Set the peak threshold and jitter range for the tracking signal (When the signal 

being tracked jitters within the specified range, the position of the center frequency will not 

change due to the signal jitter); 

 

Figure 23 Set Peak Threshold and Jitter Range 
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2. Click "Signal Track". The reference marker will search for peaks within the current sweep 

span and align the peak signal to the center frequency position. When the target signal 

frequency drifts, the spectrum analyzer will automatically adjust its center frequency so that the 

signal always remains in the center of the display area, facilitating user observation and analysis. 

 

Figure 24 Frequency Tracking 

Note: Generally, this function only moves the frequency position and does not change the span. 

However, for signals with a particularly large drift that exceed the current span, tracking 

becomes difficult. For signals at the edge of the instrument's sweep range, the span will be 

further reduced due to frequency limitations. 

6.8 Peak Table 

1. Click the "Marker" in the graph settings area. In the pop-up submenu, click "More", then click 

"Advanced". Set the threshold value for the peak table. For detailed settings, refer to the section 

Frequency Tracking; 

2. Click "Peak Table". The spectrum analyzer will automatically detect and mark the peak 

points exceeding the threshold within the current sweep span (up to 10 peaks) and display 

frequency and power information of each peak in descending order of peak signal power in the 

peak table at the bottom of the display area, enabling users to quickly view the main signals in 

the spectrum. 
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Figure 25 Peak Table 
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7. IQS Working Mode 

This chapter provides a detailed introduction for important parameters of the IQS mode, 

including time-domain IQ data and spectrum analysis, power vs. time analysis, digital down-

conversion, demodulation, etc. 

7.1 IQS Parameters Overview 

Table 15 IQS parameters overview 

Frequency 

LO optimize Please refer to SWP Working Mode for reference 

BW 

Sample rate ADC sample rate: 110 MSa/s ~ 130 MSa/s 

Analysis 
bandwidth 

Equivalent sampling rate after decimation: (ADC sampling rate / 
decimation factor)*0.8 

Data format 

8-bit: low precision, there may be many zeros in the absence of a 
signal, supporting streaming acquisition with decimate factor 
higher than 2; 
16-bit: default configuration, supporting streaming acquisition with 
decimate factor higher than 4; 
32-bit: default configuration, supporting streaming acquisition 
with decimate factor higher than 8. 

Amplitude 

Preamplifier 

Please refer to SWP Working Mode Parameters Overview in SWP 

working mode for reference 

Gain strategy 

IF gain grade 

Attenuation 

Record 

RecordMode 

Please refer to Record and Playback in SWP working mode for 
reference 

RecordTime 

FileSizeLimit 

Disk 

Playback 

Last frame 

Please refer to Record and Playback in SWP working mode for 
reference 

Next frame 

Back 

Forward 
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7.2 IQS Working Mode Overview 

The UI of the IQS mode is shown in the figure below, consisting of a maximum power vs time 

thumbnail, spectrum graph, and time-domain graph. Click "Next" in the main settings area, then 

click "Trigger". Modify the "PreviewTime" in the submenu to adjust the preview time of the IQ 

stream in the maximum power vs time thumbnail. 

The display range of spectrum graph and IQ time-domain graph are determined by the red 

selected boxes "Spectrum-P" and "IQvT-P" in the maximum power vs time thumbnail, 

respectively. By adjusting the selection range, you can observe the IQ time-domain signals at 

different time intervals, and you can also perform spectrum analysis on the IQ time-domain 

signals at different times. 

7.3 Spectrum Analysis 

7.3.1Parameter Description 

This section provides an explanation of some important parameters for spectrum analysis listed 

in table 16. 

Table 16 Parameter Description for Spectrum Analysis 

Spectrum analysis 

Window 
Please refer to SWP Working Mode Parameters Overview in SWP 
working mode for reference. 

Spectrum 
Intercept 

Spectrum interception: If Intercept = 0.8, 80% of the FFT spectrum 
analysis results are displayed in order to intercept the transition band 
spectrum components. 

7.3.2 Operation Instructions 

1. Click "FFT" in the main settings area to enable "Analyze", Drag the red box "Spectrum-P" in 

the maximum power vs time thumbnail, or adjust the values of "TimeStart" and "TimeLength" to 

perform spectrum analysis at different time intervals. Adjust the values in the "Center" submenu 

of "Frequency" and the "Span" submenu of "BW" to change the center frequency and analysis 

bandwidth; 

2. Use "FFTsize" to set the number of points for spectrum analysis, "Window" to set different 

window functions, "TraceDetector" to set different trace detectors, and "Intercept" to intercept 

and display the spectrum. When Intercept = 0.8, it can intercept the transition band. 
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Figure 26 IQ Data Spectrum Analysis 

7.4 IQvT 

7.4.1 Operation Instructions 

Click "IQvT" in the main settings area to enable "Analyze", drag the red selection box "IQvT-P" in 

the maximum power vs time thumbnail, or adjust the values of "TimeStart" and "TimeLength". 

This allows you to perform time-domain analysis at different time intervals. 

 

Figure 27 IQ Time-Domain Graph and Zoom Graph 
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7.5 PvT 

7.5.1Operation Instructions 

Click "PvT" in the main settings area to enable "Analyze". Drag the red selected box "PvT-P" in 

the maximum power vs time thumbnail, or adjust the values of "TimeStart" and "TimeLength". 

This allows you to perform power versus time analysis on IQ signals at different time intervals. 

 

Figure 28 IQ Data Power-Time Graph and Zoom Graph 

7.6 AM Demodulation 

The AM signal with a carrier frequency of 1 GHz, power of -20 dBm, modulation rate of 3 kHz 

and modulation depth of 70% is employed as an example. 

7.6.1 Parameter Description 

This section provides an explanation of some important parameters for AM demodulation, listed 

in table 17. 

Table 17 AM Demodulation Parameter Description 

Filter submenu 

n Number of filter taps. The larger the number taps, the steeper the 
transition band of the filter and the smaller the passband ripple 

Fc Cutoff frequency, 0 < Fc < 0.5. For example, if Fc is 0.25, then low-pass 
filtering is performed on half of the bandwidth. 

As Stopband attenuation. The larger the stopband attenuation, the 
stronger the suppression effect on the stopband in dB. 

mu Fractional sample offset, recommended to use the default value. 
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7.6.2 Operation Instruction 

1. Set the "Center Frequency" as 1.0001 GHz, adjust the range of the "IQvT-P" in the maximum 

power vs time thumbnail, select the IQ time domain graph, click "Graph", and choose "Auto 

Range" in the Graph submenu; 

2. Click "Demod" in the main settings area, set "Type" to AM in the submenu, select the AM 

demodulated time-domain graph, and click "Auto Range" under the "Graph" control; 

3. Click "BW" in the main settings area, increase the "Span" in the submenu to adjust the 

analysis bandwidth. In this example, set the analysis bandwidth to 12.288 MHz. 

 

Figure 29 AM Demodulation 

7.6.3 Audio analysis 

This function is used to test the demodulation sensitivity of the instrument. 

1. Refer to the AM demodulation section to demodulate the AM signal; 

2. Click "Demod" in the main settings area, open "AudioAnalysis" in the submenu, enable audio 

analysis, and check if the frequency of the audio analysis matches the modulation rate. You can 

also test the signal-to-noise ratio and total harmonic distortion. 
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Figure 18 AM Demodulation Audio Analysis 

7.7 FM Demodulation 

The FM signal with a carrier frequency of 1 GHz, power of -20 dBm, modulation frequency of 5 

kHz, and frequency deviation of 75 kHz is employed as an example. 

7.7.1 Parameter Description 

Please refer to AM Demodulation for reference. When listening to FM broadcasting, low-pass 

filtering can be applied to the demodulated FM signal to reduce some high-frequency noise, 

making the voice cleaner. 

7.7.2 Operation Instruction 

1. Set the "Center Frequency" as 1 GHz, adjust the range of the "IQvT-P" in the maximum 

power vs time thumbnail, select the IQ time domain graph, click "Graph", and choose "Auto 

Range" in the Graph submenu; 

2. Click "Demod" in the main settings area, set "Type" to FM in the submenu, select the FM 

demodulated time-domain graph, and click "Auto Range" under the "Graph" control; 

3. Click "BW" in the main settings area, increase the "Span" in the submenu to adjust the 

analysis bandwidth. In this example, set the analysis bandwidth to 6.144 MHz. 
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Figure 31 FM Demodulation 

7.7.3 Audio Analysis 

After demodulating the FM signal, please refer to Audio Analysis section to analyze the 

demodulated signal.  

7.8 DDC-Digital Down Conversion 

Perform digital down-conversion and resampling on the IQ data stream to generate sub-IQ 

streams for further spectrum analysis. Taking the DDC of a single-tone signal with a frequency 

of 1 GHz and power of -20 dBm as an example. 

7.8.1 Parameter Description 

This section provides an explanation of some important parameters for digital down-

conversion (DDC), listed in Table 18. 

Table 18 DDC Parameter Description 

Sampling submenu 

OffsetFreq 
Frequency offset of complex mixing 
>0: Spectrum shifts to the right 
<0: Spectrum shifts to the left 

Decimate decimation factor for the DDC, i.e., the resampling rate 

7.8.2 Operation Instruction 

1. Set "Center" as 1 GHz and "Ref.Level" to 0 dBm. Adjust the range of "IQvT-P" in the maximum 

power time thumbnail, select the IQ time-domain graph, click "Graph", and choose "Auto Range" 

from the Graph submenu; 

2. Click "DDC" in the main settings area, click “State on” in the additional submenu to enable 

"Channel1", and set the "Center" of the DDC1 channel to 1.003 GHz, "OffsetFreq" to -3 MHz, 

"Step" to 1 MHz, and "Decimate" to 3; 
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3. Click "FFT" in the main settings area, select "DDC1 Channel" from the dropdown menu, 

enable "Analyze", drag the red selection box "Spectrum-D1" in the maximum power time 

thumbnail, or adjust the "TimeStart" and "TimeLength" values to perform spectrum analysis on 

the sub-IQ streams generated by the DDC at different time intervals; 

4. Click "IQvT" in the main settings area, select "DDC1 Channel" from the dropdown menu, 

enable "Analyze", drag the red selection box "IQvT-D1" in the maximum power time thumbnail, 

or adjust the "TimeStart" and "TimeLength" values to perform time-domain analysis on the sub-

IQ streams generated by the DDC at different time intervals; 

 

Figure 32 View Time-Domain Graph of IQ Substream under DDC 

5. Click "PvT" in the main settings area, select "DDC1 Channel" from the dropdown menu, 

enable "Analyze", drag the red selection box "PvT-D1" in the maximum power time thumbnail, or 

adjust the "TimeStart" and "TimeLength" values to perform power vs. time analysis on the sub-

IQ streams generated by the DDC at different time intervals. 
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Figure 33 View Power-Time Graph of IQ Substream under DDC 

8. DET Working Mode 

This chapter provides a detailed introduction to some parameters of the DET mode and the 

measurement of pulse signals in this mode. 

8.1 DET Parameter Description 

This section provides an explanation of some important parameters for the DET mode, listed in 

Table 19. 

Table 19 DET working mode description 

Frequency 

LO optimize Please refer to SWP Working Mode Parameters Overview in SWP 
working mode for reference 

Amplitude 

Preamplifier 

Please refer to SWP Working Mode Parameters Overview in SWP 
working mode for reference 

Gain strategy 

IF gain grade 

Attenuation 

8.2 Pulse Signal Measurement 

A pulse modulation signal with a carrier frequency as 1 GHz, power of -10 dBm, pulse period of 

80 µs, and pulse width of 40 µs as an example. 

8.2.1 Operation Instruction 

1. Set the "Center" as 1 GHz and click the "Single" in the menu bar to enable the single preview 

mode; 
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2. Click "Graph" in the chart settings area, then click "Zoom" to enable zooming. Adjust the 

zoom area by dragging the selected zoom area or dragging the zoom border left or right; 

3. Select the zoomed-in graph, click "Graph" in the chart settings area, and choose "Marker 

Pair" to create two pairs of markers. Move the M1R marker to the pulse rising edge, M1D marker 

to the same pulse falling edge, M2R marker to the pulse rising edge, and M2D marker to the next 

pulse rising edge. The results displayed by the M1D and M2D markers in the top left corner of 

the zoomed-in graph will be the pulse width and pulse period of the pulse signal, respectively. 

The duty radio can be calculated using the following formula. 

Duty radio =
Pulse width

Pulse period
 

 

Figure 34 Measure Pulse Signal Period and Width 

8.3 Pulse Signal Detection (Option) 

This chapter introduces the basic operation methods for pulse signal detection and how 

customers who purchase the pulse detection option later can obtain and place the license. 

8.3.1 Apply for License 

If the pulse detection option was included when you purchased the device, you can ignore the 

content of this section. If you purchase the pulse detection option later, please follow the steps 

below to obtain and place the pulse detection license to use this feature properly. 

1. Refer to the Current Instrument Information section to view the soft firmware version; 

2. Ensure the version meets the following requirements; 

▪ GUI Version: 4.3.55. 6 or above 

▪ API Version: 0.55. 55 or above 

▪ FPGA Version: 0.55. 15 or above 

▪ MCU Version: 0.55. 32 or above 

3. If the software and firmware versions do not meet the above requirements, please contact 

official technical support to update to the required versions;  
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4. Click "File" -> "Exit" to exit the application software running interface; 

5. Copy the "PX_Demod" file which obtained from technical support to a USB drive, then 

connect the USB drive to the USB port on the instrument's front panel, and click "OK" in the pop-

up window "Removable medium is inserted"; 

6. Copy the "PX_Demod" file from the USB drive to the desktop by dragging and dropping; 

7. Enter the "PX_Demod" folder, click "Tools" to open the terminal. Type sudo sh install.sh and 

press Enter. After entering the password rpdzkj when prompted, press Enter again. When the 

terminal displays "The option has been successfully installed" the installation is complete; 

 

Figure 35 Install License of Pulse Detection Option 

8. Close the pop-up window and launch the Application Software software, click "Mode" in 

the menu bar, select "Power Detection" to enter the detection analysis mode, enable "Pulse Det" 

in the main settings area, and the pulse signal detection function can be used normally. 

 

Figure 36 Enable Pulse Detection Measurement 

8.3.2 Parameter Description 

Only some important parameters are explained here: Important parameters for pulse signal 

detection are shown in Table 20.  
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Table 20 Pulse Signal Detection Parameter Description 

Pulse Det 

Threshold 
Pulse detection threshold, only pulse signals greater than this 
threshold value will be considered valid pulses. 

Maximum Number 
of Pulses 

Upper limit of pulse signal detection at current preview time 

8.3.3 Operating Steps 

Taking the detection of a pulse signal with 1 GHz, -20 dBm, pulse width of 40 µs, and pulse 

period of 80 µs as an example. 

1. Set "Center" to 1 GHz and "Ref.Level" to 0 dBm; 

2. Click "BW" in the main settings area and adjust the value of "BW" in the additional menu to 

set different analysis bandwidths. In this example, set "AnalysisBW" to 61.44 MHz; 

3. Click "Trigger" in the main settings area and set "PreviewTime" to 500 µs ; 

4. Click "Pulse Det" in the main settings area to enable the pulse detection function. Drag the 

value of "Trigger.Level" in the power time graph to set the pulse detection threshold, and adjust 

the value of "PulseCount" to set the upper limit of pulse signal detection under the current 

preview time; 

5. Click "Single" in the menu bar, and the pulse detection results under the current 

configuration are shown in the figure below. From the figure, you can obtain parameters such 

as the peak level (dBm), reference level (dBm), rise time, leading edge, fall time, trailing edge, 

pulse width, period, and duty cycle of each detected pulse signal. Also, the statistical 

parameters of the detected pulse signals, such as the maximum, minimum, average pulse period 

and width, period deviation percentage, and pulse width deviation percentage. 

 

Figure 37 Result of Pulse Detection 
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9. RTA Working Mode 

This chapter provides a detailed introduction to some parameters of the RTA mode and the 

measurement of WIFI signals in this mode. 

9.1 RTA Parameter Description 

This section provides an explanation of some important parameters: Important parameters for 

RTA mode are listed in Table 21. 

Table 21 RTA mode parameter description 

Frequency 

LO optimize 
Please refer to SWP Working Mode Parameters Overview in SWP 
working mode for reference 

Amplitude 

Preamplifier 

Please refer to SWP Working Mode Parameters Overview in SWP 

working mode for reference 

Gain strategy 

IF gain settings 

Attenuation 

Sweep 

Sweep Time Mode Please refer to SWP Working Mode Parameters Overview in SWP 

working mode for reference Window 

9.2 Probability Density Graph 

9.2.1 Parameter Description 

Graph 

Probability Graph 
On: Enable probability density graph display 
Off: Disable probability density graph display 

Color Scale 
Sky color, Deep sea color (default), Jet color, Cool color, 
Hot color, Grayscale 

Afterglow 

Increase: Extend the signal afterglow display time, 
suitable for capturing burst signals 
Reduce: Speed up refresh rate, suitable for tracking 
continuous signals 

9.2.2 Close Probability Density Graph 

Click "Graph" in the chart settings area, and in the pop-up window, close "BitMap" to close the 

probability density graph. 
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Figure 38 Turn Off BitMap 

9.3 WIFI Signal Measurement 

1. Connect the antenna to the RF input port "RFIN"; 

2. Set the "Center" as 2.44 GHz. Increase the "Afterglow" value in the "Graph" submenu of the 

chart settings area to observe the WIFI signal more clearly. 

 

Figure 39 BitMap of WIFI Signal 
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10. Digital demodulation (option) 

This chapter introduces the basic operation methods of digital demodulation and how 

customers can enable the digital demodulation function through a license. 

10.1 Apply for License 

If your device purchase includes the digital demodulation option, you can ignore the content of 

this chapter. If you purchase the digital demodulation option later, please follow the steps 

below to obtain and place the digital demodulation license for normal use of this function. 

1. Refer to Apply for License chapter to apply for the corresponding "PX_Demod" folder. And 

install the corresponding license and demodulation library with a single command by executing 

sudo sh install.sh; 

2. Close the pop-up window and launch application software, click on the "Mode" menu, 

select "Digital Demod", and you can use the digital demodulation function normally. 

10.2 Parameter Description 

Here, only some important parameters are explained: Some important parameters are shown in 

Table 22.  

Table 22 Parameter Description for Digital Demodulation 

Digital Demod 

SymbolRate 
The number of symbols transmitted per second by the signal needs 
to be filled in according to the symbol rate of the modulated signal 
to ensure that the receiving end can demodulate correctly 

ModType 2ASK, 2FSK, 4FSK, GMSK, BPSK, QPSK, 8PSK, 16QAM, 64QAM, 
128QAM, 256QAM 

FilterAlpha 

The roll-off rate of the filter used to limit the signal bandwidth in the 
transition band must be consistent with the roll-off coefficient at 
the transmitter to ensure that the demodulator can effectively 
process and demodulate the signal correctly. 

10.3 Function Overview 

The initial UI of the digital demodulation mode consisting of the modulation signal spectrum, 

demodulated constellation diagram, eye diagram, and demodulation parameters. It allows for 

an in-depth analysis of the modulation quality of the signal and provides various error metrics 

to effectively evaluate the integrity and reliability of the signal during transmission. 

10.4 Operating Steps 

Take the demodulation of a 1 GHz, -20 dBm, symbol rate 100 kHz, filter roll-off factor 0.35, 

64QAM signal as an example. 

1. Set "Center" to 1 GHz, "RefLevel" to 0 dBm; 

2. Click "Demod" in the main settings area, set "ModType" in the additional menu to QAM64, 

"SymbolRate" to 1 MSPS, "FilterType" to 0.35, and click "Single" in the menu bar. The 

demodulation result under the current configuration is shown in the figure below. The 

constellation points in the constellation diagram are clear and closely distributed, with the 

theoretical and actual demodulation point positions almost coinciding, indicating high 
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modulation quality of the signal and good overall performance of the communication system. 

The eye diagram is clear with a large opening, indicating minimal inter-symbol interference, 

allowing the receiver to reliably distinguish symbols. Meanwhile, it also provides error vector 

magnitude (EVM), amplitude error, phase error, frequency error, signal-to-noise ratio 

(SNR/MER), and part of the decoded bit sequence. 

 

Figure 40 64QAM Demodulation 
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11. Harmonic Analysis mode 

11.1 Version Requirements 

1. Refer to the Current Instrument Information section to view the soft firmware version. 

2. Ensure the version meets the following requirements 

▪ GUI Version: 4.3.55.24 or above 

▪ API Version: 0.55.0 or above 

▪ FPGA Version: 0.55.0 or above 

▪ MCU Version: 0.55.0 or above 

3. If the GUI version does not meet the above requirements, please contact the official 

technical support to obtain the appropriate version of the host computer software. 

11.2 Enable Harmonic Analysis Function 

After updating the software/firmware to the required version, restart the application software, 

click "Mode" in the menu bar, and select "Harmonics" to use the harmonic analysis measurement 

function normally. 

11.3 Parameter Description 

Table 23 Harmonic Analysis Mode Parameter Description 

Frequency  

Center Center frequency of the fundamental. 
Span  

Span 
Measured width of each order of harmonics. Range: 10 Hz - 100 
MHz. 

Amplitude  

Offset Adjusting the position of the spectrogram on the amplitude axis. 

Meas  

Harm Count 
Set the number of harmonics to be measured and plotted, up to a 
limit of 10. 
 

Meas Type 

Peak: Measurement of peak power at fundamental and harmonics 
of each order; 
ChannelPower: Measurement of channel power for fundamental 
and harmonics in their respective sweep widths. 
 

Trace Type 

ClearWrite: Real-time updating of spectrograms, suitable for 
observing transient changes in signals; 
MaxHold: Holds the peak value of the displayed signal, suitable 
for capturing transient peaks. 
 

PK Tracking 
On: Enables peak tracking of the fundamental signal, aligning the 
fundamental signal peaks to the center frequency. 
 

THD Used to measure signal distortion. 

11.4 Operation Steps 

As an example, the third harmonic of a 1 GHz, -20 dBm signal is measured. 

1. Click "Frequency" in the main settings area, and in the additional menu, set "Center 
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Frequency" to 1 GHz; 

2. Click "Amplitude", set the reference level to -10 dBm; 

3. Click "Meas", set the "Harm Count" to 3 and turn on "PK Tracking", leave the other 

parameters as default; 

4. Click "Span", set the "Span" to 10 MHz; 

5. Click "BW", adjust the values of "RBW" and "VBW" to smooth the trace. In this example, 

"RBW" is set to 1 kHz and "VBW" is set to 100 Hz; 

6. The results of the tests are shown in the figure below, with the total harmonic distortion 

(THD) shown in the upper right-hand corner of the spectrum. The frequency and amplitude of 

the second and third harmonics and their difference from the fundamental are listed in the 

harmonic measurement table below. 

 

Figure 41 Third Harmonic Measurement 
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12. Phase Noise Measurement Mode 

12.1 Version Requirements 

1. Refer to the Current Instrument Information section to view the soft firmware version; 

2. Ensure the version meets the following requirements; 

▪ GUI Version: 4.3.55.12 or above 

▪ API Version: 0.55.58 or above 

▪ FPGA Version: 0.55.17 or above 

▪ MCU Version: 0.55.49 or above 

3. If the software/firmware version does not meet the above requirements, please contact 

official technical support to update the software/firmware to the required version. 

12.2 Enable Phase Noise Measurement Function 

After updating the software/firmware to the required version, restart the application software, 

click "Mode" in the menu bar, and select "Phase Noise" to use the phase noise measurement 

function normally. 

 

Figure 42 Enable Phase Noise Measurement 

12.3 Parameter Description 

Only some important parameters are explained here: Some important parameters of phase 

noise measurement are shown in Table 24. 

Table 24 Phase Noise Measurement Mode Parameter Description 

Frequency  

Center Setting the center frequency of the fundamental. 

Start Offset Set the starting point of the frequency offset, range: 1 Hz~9 MHz 

Stop Offset Sets the end point for the frequency offset, range: 10 Hz~10 MHz 
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Carrier Search 
Search the entire frequency band to locate signals above the 
carrier identification threshold. 

Threshold 
Set the carrier identification threshold; only carriers above this 
threshold will be identified. 

Meas  

RBW/Offset 
RBW ratio (RBW of each frequency segment / starting frequency 
of each frequency segment), range: 0.01~0.3 

Detect 

Frame Detection Rate: Recommended to use the default 
configuration. If there is obvious low-frequency jitter near the 
signal under test, the frame detection rate near the end can be 
increased to obtain more stable measurement results. 

Trace  

Average Sets the number of trace averages 

Smooth(on/off) On: Enables trace smoothing function 
Off: Disables trace smoothing function 

Smooth(%) Sets the window length of the smoothing algorithm, range: 0~10% 

12.4 Operation Steps 

12.4.1 Phase Noise Measurement with Known Carrier Information 

Taking the measurement of phase noise of a 1 GHz, 0 dBm signal in the 100 Hz to 10 MHz 

offset range as an example. 

1. Click ‘Frequency’ in the main settings area, and in the additional menu, set ‘Center’ to 1 GHz, 

“Start Offset” to 100 Hz, and “Stop Offset” to 10 MHz. It is recommended to use the default 

configuration for the remaining parameters; 

2. If there is strong jitter at the near end of the signal under test, click "Meas" in the main 

settings area, then select "Detect" in the additional menu. In the pop-up window, appropriately 

increase the frame detection rate of the corresponding frequency band to obtain more 

convergent measurement results; 

 

Figure 43 Settings of Pulse Signal Detection  
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3. If there are obvious spurs in the single sideband phase noise spectrum, you can click "Trace" 

in the main settings area, then select "Smooth(%)" in the additional menu, and gradually increase 

its parameter value to reduce the interference of spurs on the measurement results; 

4. The instrument will automatically complete the phase noise measurement within the set 

frequency offset range, and the measurement results are shown below. In the phase noise 

measurement table at the bottom of the interface, you can obtain the carrier information and 

the phase noise values of each characteristic frequency offset point (unit: dBc/Hz). 

 

Figure 44 Result of Phase Noise Measurement 

12.4.2 Phase Noise Measurement of Unknown Carrier Information 

When the signal carrier parameters are unknown, it is recommended to perform phase noise 

measurement according to the following process.  

1. Click "Carrier Search", the instrument will automatically perform a full-band scan, search for 

and locate the peak signal exceeding the carrier threshold as the carrier under test; 

2. After locating the carrier signal, refer to the Phase Noise Measurement of Known Carrier 

Information section to set the start frequency offset and end frequency offset for phase noise 

measurement. 
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13. Additional Functions 

In this chapter, you can find detailed information for how to operate GNSS, trigger and remote 

control etc. 

13.1 Trigger Features Overview 

13.1.1 SWP Working Mode 

Trigger In 

Trigger Source FreeRun, Ext. PerHop, Ext. PerSweep, Ext. PerProfile 

Trigger Edge RisingEdge, FallingEdge, DoubleEdge 

Trigger Out 

Trigger Out 

Null; 

PerHop: Output a trigger after each frame analysis is completed  

PerSweep: Each time a trace scan is completed, a trigger is output  

PerProfile: Outputs a trigger for each switching configuration  

Trigger Out Pulse 
Polarity Positive、Negative 

13.1.2 IQS、DET、RTA Working Mode 

Trigger In 

Trigger Source 
External, Bus, Level, Timer, DevSyncByExt, DevSyncBy1PPS, 

GNSS1PPS 

Trigger Edge RisingEdge, FallingEdge, DoubleEdge 

Trigger Delay Set the delay time after triggering 

PreTrigger Set the acquisition time before triggering 

ReTrigger 
At FixedPoints mode, the instrument responds multiple times 

after capturing a trigger 

Count 
After a single trigger response, several additional responses are 

required 

Period 
The time interval between multiple responses of a single-trigger 

instrument is same as trigger period in the timer trigger mode  

Trigger In- Level 

Trigger Level 
Set the level trigger threshold value. If the value is higher than the 

threshold value, it means the trigger condition is met.  

Debounce SafeTime Set the level-triggered debounce safety time 

TriggerIn-Timer 

Period Trigger period in timer trigger mode 

Sync Not synchronized with the external trigger 
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Synchronized with the external trigger’s rising edge  

Synchronized with the external trigger’s falling edge  

Single-shot synchronization with the external trigger’s rising 

edge 

Single-shot synchronization with the external trigger’s falling 

edge 

Synchronization with the GNSS-1PPS rising edge 

Synchronization with the GNSS-1PPS falling edge 

Single-shot synchronization with the GNSS-1PPS rising edge 

Single-shot synchronization with the GNSS-1PPS falling edge 

13.2 IF Output 

The frequency of the analog IF output signal is between 307.2 MHz ±  50 MHz. The center 

frequency of the analog IF output of each instrument can be viewed in the IF calibration file of 

the instrument. 

 

Figure 45 Check Center Frequency of IF Output 

13.3 External Reference Clock Input 

The waveform of the reference clock input can be selected as sine wave, square wave or 

clipped sine wave. The frequency must be set to 10 MHz and the amplitude must be 3.3V CMOS 

level. 

Below is the GPSDO as the 10 MHz reference clock input: 

1. Connect the GPSDO "10 MHz" port to the instrument's "RI" port via a BNC to MMCX cable. 

The connection is shown below; 
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Figure 46 10MHz Reference Clock Input 

2. Click "Next"-"System" in the main setting area, set the reference clock frequency 

"RefCLKFreq" to 10 MHz, and select "External" for the reference clock source "RefCLKSource". 

If the reference clock source displays "External", it means the switch is successful. If the 

reference clock source rebounds to "Internal" and an error pop-up window appears, it means 

the switch failed. At this time, you can click "Preset" to switch back to the internal clock. 

 

Figure 47 Use External 10MHz Reference Clock 

13.4 Remote Control 

13.4.1 Using LAN Port 

1. Connect the driver-free expansion dock with network port to the USB port on the upper 

panel of the instrument (USB3 is USB3.0 port, USB1 and USB2 are USB2.0 ports); 



 

59 

 

Figure 48 External Driver-Free Docking Station with Network Port 

2. Connect the expansion dock to the network port of the computer or embedded instrument 

via a network cable; 

3. Click "File" - "Exit" in the menu bar to exit application software; 

4. After successfully connecting according to the above steps, open "Settings", select 

"Network & Internet", and click "Properties"; 

5. Enter Ethernet, find the IP section and click "Edit", select "Manual" to set IP, turn on the IPv4 

option, and set the IP address and subnet mask (the computer IP and the instrument IP must be 

in the same network segment). For example, set the computer IP address to 192.168.1.2 and the 

subnet mask to 255.255.255.0; 

 

Figure 49 IP Address and Subnet Mask 

6. Open the cmd window and enter "ping 192.168.1.100". If it can be pinged, the network 

connection is successful; 

 

Figure 50 Test Network Connection of Instrument (ping command) 

7. Go to the configuration folder of application software on the PC, double-click to open the 
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Settings.ini file, and set Interface to ETH; 

 

Figure 51 Change the Settings of Settings.ini  

8. Click the Userdata directory on the instrument's desktop, navigate to the 

"/media/rpdzkj/userdata/Studio/bin/CalFile " folder within the host software folder, and drag 

and drop the calibration files to save them to the external storage device. 

 

Figure 52 Obtain Instrument Calibration File 

9. Copy the instrument calibration file to the "Studio/bin/CalFile" directory within the host 

software folder on the PC. Then, double-click the executable program in the "bin" directory to 

open the software interface and enable remote control of the PX series instrument. 
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Figure 53 Remote Control of PX Instrument via Direct Ethernet Connection 

Note: The application software on the PC and instrument cannot be opened at the same time. 

13.4.2 Using Local Area Network 

1. Connect the driver-free expansion dock with network port to the USB port on the upper 

panel of the instrument (USB3 is USB3.0 port, USB1 and USB2 are USB2.0 ports); 

2. Connect the Hub to the router's network port via an Ethernet cable; 

 

Figure 54 Connect Router and Instrument 

3. Click "File" -> "Exit" in the menu bar to exit application software; 

4. Click "userdata" -> "Tools" -> "Open Current Folder in Terminal"; 

 

Figure 55 Open Terminal 

5. Enter "ifconfig" in the terminal to query the IP address assigned to the instrument by the 
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current router. In this example, the IP address is "192.168.31.55"; 

 

Figure 56 Query Dynamic IP of Instrument 

6. The PC connects to the same router via WIFI, and both the spectrum analyzer and the PC 

are in the same local area network. Then, navigate to the configuration folder in the host 

software directory, double-click to open the Settings.ini file, set the Interface to ETH, and set 

the Address to "192.168.31.55". 

 

Figure 57 Modify the Settings.ini 

7. Click the Userdata directory on the instrument's desktop, navigate to the 

"/media/pdzkj/userdata/Studio/bin/CalFile " folder within the host software folder, and drag 

and drop the calibration files to save them to the external storage device. 

 

Figure 58 Obtain Instrument Calibration File 
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8. Copy the instrument calibration file to the " Studio/bin/CalFile " folder within the PC host 

software directory. Then, double-click the executable program in the "bin" directory of the host 

software folder to open the interface and enable remote control of the PX series instrument. 

 

Figure 59 Remote Control PX Instrument via LAN  
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14. Software and Firmware Update 

This chapter explains how to update the instrument's application software using the .deb 

package. 

14.1 Software Update Rules 

The instrument's MCU firmware, FPGA firmware, and software (API) can only be used together 

within the same major version. They are not compatible between different major versions. For 

example, only versions like 0.55.x can be used together. 

Version Viewing: Refer to Current Instrument Information section. 

14.2 Software Update Using .deb Package 

1. Obtain the PX series software installation package through official technical support and 

copy it to a USB flash drive. 

2. Open the instrument normally, click "File" -> "Exit" in the menu bar to exit Application 

Software. 

3. Use a hub with a USB or Type-C interface to connect the USB flash drive carrying the .deb 

installation package and the mouse and keyboard to the instrument. 

 

Figure 60 External USB drive, mouse, and keyboard 

4. Copy the .deb installation package in the USB flash drive to the instrument. 

5. Click Tools, then click Open Current Folder in Terminal to open the terminal. 
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Figure 61 Open Terminal 

6. Enter command: cd ~/Desktop/ to enter the desktop. 

7. Type sudo dpkg -i EN_PXConfig_2.55.22.23.deb(Note: When entering the command, the 

version of the deb package "EN_PXConfig_3.55.22.23.deb" should be entered according to the 

actual version used) to Install the .deb installation package and enter the password rpdzkj as 

prompted; 

 

Figure 62 Application Software Update 

8. Wait for the installation package to finish running, the device will automatically reboot and 

enter the new version of the host computer software interface, this time the host computer 

software installation is complete; 

9. Click "System" in the menu bar, select "About" in the drop-down menu, and check whether 

the GUI and API in the pop-up window have been updated to the latest version. 

14.3 Handling Accidental Deletion of Application Software  

If the host software is accidentally deleted during normal use of the instrument, resulting in the 

instrument becoming unusable, you can follow the .deb installation package update procedure 

to restore the host software. 
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